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ICATS IT CONTEST 2017

JUNIORS (GRADE 5 & 6)

TIME ALLOWED : 90 MINUTES
MAXIMUM MARKS : 90
TOTAL QUESTIONS : 30 MCQS

INSTRUCTIONS
DON'T START ATTEMPTING THE PAPER UNTIL INSTRUCTED BY THE INVIGILATORS.
INSTRUCTIONS FROM THE EXAMINATION INVIGILATORS MUST BE CARRIED OUT
PROMPTLY.
WRITE YOUR NAME, FATHER NAME, SCHOOL NAME, ADDRESS ETC AT THE BUBBLE SHEET
(ANSWER SHEET) ONLY.
RECORD ALL ANSWERS ON THE BUBBLE SHEET ONLY. SELECT BEST ANSWER FROM THE
FOUR GIVEN OPTIONS AND MARK ONLY ONE OPTION IN EACH QUESTION.
USE BLUE / BLACK INK TO FILL UP THE CIRCLES FOR YOUR ANSWERS ON THE BUBBLE SHEET.
USE OF LEAD PENCIL IS NOT ALLOWED.
USE OF ANY HELPING MATERIAL INCLUDING CELL PHONES AND ELECTRONIC DEVICES IS
STRICTLY PROHIBITED.
EVERY CORRECT ANSWER EARNS THREE POINTS. THERE WOULD BE NEGATIVE MARKING.
ONE POINT WOULD BE DEDUCTED FOR EVERY INCORRECT ANSWER.
CANDIDATES MAY NOT LEAVE THE EXAMINATION ROOM UNESCORTED FOR ANY REASON,
AND THIS INCLUDES USING THE WASHROOM.
. NO MATERIALS OR ELECTRONIC DEVICES SHALL BE BROUGHT INTO THE ROOM.

. THERE ARE FIVE CATEGORIES OF THE CONTEST AS UNDER:
A TODDLERS (GRADE 1 & 2)
B. KIDS (GRADE3 &4)
C. JUNIORS (GRADE5 &6)
D JUVENILES (GRADE 7 & 8)
E. ADOLESCENTS (GRADE 9 & 10 / O-LEVELS)

. ONLY REGISTERED STUDENTS CAN PARTICIPATE IN THE CONTEST.

. NO CANDIDATE SHALL TAKE OUT OF THE HALL ANY ANSWER BOOK(S) OR PART OF AN
ANSWER BOOK, WHETHER USED OR UNUSED, OR OTHER SUPPLIED MATERIAL.

. IF A PARTICIPANT DOES NOT UNDERSTAND A WORD OR PHRASE ON THE EXAM PAPER,
NEITHER EXAMINER NOR INVIGILATOR IS PERMITTED TO ANSWER.

. FOR INFORMATION ABOUT UPCOMING CONTESTS OR PROVIDING VALUABLE FEEDBACK,
PLEASE VISIT WWW.CATSCONTESTS.ORG

. ANY ACADEMIC MISCONDUCT OR MALPRACTICE MUST BE REPORTED TO INTERNATIONAL
CATS CONTESTS AT INFO@CATSCONTESTS.ORG
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m Mark I is also known as

I American Sequence Controlled Calculator
E Automatic Sequence Calculating Controller
American Sequence Controlled Computer

E Automatic Sequence Controlled Calculator

m What is X known as?

— TS

Utsavi 1032
Priya 103
Mahi 1030

u Edit E Row E Cross head E Cell

XD The direction of a rectangular page for viewing and printing is called

E Direction Print Layout

E Preview

ﬂ Orientation

m Which one is the MOST correct option for deleting tab |- [ponations:

stops from a list:
1,000,000

250,000

ﬂ Select the list. Double click the tab stops you wish to remove. o
E Select the list. Click the Tab Selector until it displays a blank box. E 35,000

E Select the list. Click and drag individual tabs off of the Ruler to
remove them.

100,000

2,300,000

E In the Tab dialogue box click Clear All to remove all tabs. -

ICATS IT Contest 2017 (Juniors - Grade 5 & 6)



Page 2 of 12

m ———— e =
H e | M bieed v e tees e sk -

B - KT = e e R [ e | asmcin Aainty asnee AQL A B

e A AR EERREE S Yovwma |120 5o syt 1 e Quear o s

wie |
=t - Farrgm .

I Fl

- oy : =

International CATS competitions have
been developed by a team of well
experienced professionals from around
the world.

These competitions play key role to
motivate students to perform, excel and
gain substantial experience, exhibit skills,
question and gauge outcomes and reveal

Which tool will allow Raja to move his word processing document around so
that he can view different sections?

N undo I spell check [ scroll bar B) Alignment

T Wwhat is the function of the icon circled in red in the image below?

Documentl - Micrasoft Word =
Mallings Review View Add.dns wl
Rl e =l i =l A T 3 Fing -
Al = m Eas i |aaBbCcDe | AaBbCcDc AaBbC AaBble Aab - g
- i =%
V@ EEaAEEl= S5 fMormal | TNo Spaci.. Hesdingl  Heading 2 Titte . Change

Styles = || Wf Seteat -

Faagroph ip Shyles Edting

u It is a toggle switch to hide or display the vertical and horizontal rulers.

B It is a toggle switch to hide or display the vertical and horizontal scroll bars.
E It is the function button to enlarge the screen size or make it smaller.

E It is a shortcut that takes you to the top of the document.

ICATS IT Contest 2017 (Juniors - Grade 5 & 6)
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To switch between the running applications, you need to

I Press Fi I3 Press Alt + F4
E Press Tab E Press and hold down Alt and press Tab
€D Google allows up to sizes of files to be exchanged through e-mail.

Y 40 M8 3 1omB I somB 2] 25 B

T} Which of the following statements is correct?

ﬂ info@catscontests.org is a web site (url).
5] info@catscontests.org is an email address.
E info@catscontests.org is a computer name.
E info@catscontests.org is a robot.

You want to indent the first line of a paragraph in a document. How do you
do it?

ﬂ Press “tab” once at the beginning of the paragraph.
E Type five spaces at the beginning of the paragraph.
Type “tab” 5 times at the beginning of the paragraph.

E Copy and paste five spaces at the beginning of the paragraph.

ICATS IT Contest 2017 (Juniors - Grade 5 & 6)
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(3E§ What might be attached to a USB port on you computer?

u A television set B A monitor E A cable modem E Printer

B} 1f you want to save a modified image, what is the best format?

ﬂ .doc B html E .pdf E .jpg

You have a spreadsheet under the name “"MathResults”. You made changes to
it and want to save it while maintaining a copy of the original spreadsheet,
what do you do?

N Click the icon 2} click “Save” in the file menu
Click “Save As” in the file menu E Used the shortcut CTRL/S

I} what does COUNTA () function do?

ﬂ Counts non-empty cells E Counts cells having number
E Counts cells having alphabets E Counts empty cells

CIE) what is the correct way to refer the cell A10 on sheet3 from sheet1?

N sheet3!A10 3 sheet1!A10 [ Ao ) sheet3.A10

ICATS IT Contest 2017 (Juniors - Grade 5 & 6)




Page 5 of 12

m If you want to have a blank line after the title in a worksheet, what is the best
thing for you to do?

u Re-format the spreadsheet E Use the Spacebar
E Increase the column width E Insert a row

You are looking at an online multimedia presentation, and some of the
features do not load. What is the most likely reason?

ﬂ Your digital camera is not plugged in E You have an outdated version of the software

Your screen is not big enough E You do not have a CD drive

m Who will receive the first copy of the following email?

From saudbhorra@noyosystenﬁ.com [
T a@z.com

~l€¢  b@z.com, c@z.com

=1Bec  d@z.com, é@z.com

Add Reply-To
Subject

W, Attachafile

ﬂ b@z.com E a@z.com E b@z.com, c@z.com E d@z.com, e@z.com

m Find the odd one out.

ﬂ Windows Explorer E Google Chrome ﬂ Mozilla Firefox E Internet Explorer

ICATS IT Contest 2017 (Juniors - Grade 5 & 6)
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How was I able to make the text flow around the picture as above?

ﬂ I used the Change Picture tool. E I used the Send Background tool.
I used the Wrap Text tool. E I used the Crop tool.

m BIOS is stored on

Y Magnetic 5] roM Scanner ] omR

XX} The platters of hard disc are coated with material.

u Magnetic B OMR Scanner E LASER

ICATS IT Contest 2017 (Juniors - Grade 5 & 6)
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m t Word E
m ’AaBchDc AaBbCeDc AaBbCi AaBbCc Aalj %.
T Normal

1 Mo Spaci.. Headingl Heading2 Title :‘yalnge
es -

I Styles I
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Study the screenshot above. What will happen if you click the arrow circled
in red?

ﬂ This will launch the Style Set list. E This will apply the selected Style.
E This will expand the Quick Styles Gallery E All of the options listed above are incorrect.

m Study the screenshot, especially the area circled in red, below. What is the
purpose of the function labelled “Continue From Previous Section”?

[ Page Number Format (9 S

Humber format: E]
Indude chapter pumber

Page numberng
9 Contrue from previous section ]
at

ok | [ canee

[N 1t links one section of a document to another section and ensures a Header or Footer is the
same as the previous section.

E It links page number formatting from one section and ensures it is the same as the previous
section.

E It links Section Breaks by creating “Continuous Section Breaks” which ensures page numbering
is the same as the previous section.

E It continues the value of the page numbering from one section to another section without
restarting the numbers.

ICATS IT Contest 2017 (Juniors - Grade 5 & 6)
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Alina wishes to recreate the above formatting in a document using automatic
page numbering as she has to create hundreds of sheets. Is it possible to do
this?

ﬂ Yes, she can insert a page number with her cursor positioned in the table.

E No, unfortunately page numbers can only be inserted in the Header or Footer region of a
document.

E No, unfortunately page numbers can contain limited formatting only.
E Yes, but only if she inserts a section break before every page she inserts.

“ Home nsert Page Layout Formuias Data Renew
== % Cut

—' U3 Copy -
Paste

Calibri 12 ~ A A

= = =
- s 1 R A == == . ~
J Eormat Painter B I U — > A EESE FF HMeageace

b 5’. Wrap Text

Resident Total

Study the screenshot above. How do you get the Quick Access Toolbar to
display below the Ribbon (as circled in red in the screenshot above)?

I[N Right-click the Quick Access Toolbar and select Show Quick Access Toolbar Below the
Ribbon from the list.

B Click the down-pointing arrow to the right of the last option on the Quick Access Toolbar and
select Show Below the Ribbon from the list.

E In the Customize the Quick Access Toolbar area of the Excel Options dialog box, tick the box
for Show Quick Access Toolbar Below the Ribbon.

) Al of the options listed above are correct.

ICATS IT Contest 2017 (Juniors - Grade 5 & 6)
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Study the red circled cells in the image below and identify which of the
following represents the correct cell address for these cells:

A B G
1 Data Result Formula
2 14 71  =A2+A4
3 7 78  =SUM(A2:A4)
4 57 71 =SAS2+3A%4
5 71  =S5A2+A%4
6 12 =A3+Sheet2!A2
7 13 =A3+[Book2]Sheet1!$AS2

I The cell reference for the circled cells is A:2, B:3 and C:4
E The cell reference for the circled cells is row A4, B4, C4
The cell reference for the circled cells is A1:C4

E The cell reference for the circled cells is A4:C4

Study the orange circled area of the worksheet in the image below. Which of
the following best describes the function of this area?

Total_Sales - £ | Total sales
| A B c D : F

4

5 Qtrl Qtr2 Qtr3 Qtra Total

6

7 [Total sales 50000 78200 89500 91250 308350
8 |Cost of sales 25000 42050 59450 60450 186950
_9_ Gross profit 25000 36150 30050 30800 122000
10

11 [Overhead 7500 7520 5620 3520 24160
12 |Marketing 7000 6630 4500 3200 21330

ﬂ The Name Box displays a name given to a cell or set of cells.
5] The Name Box reflects the contents of the first cell that is selected in a range.
E The Name Box gives you options for duplicating the selected cells.

E All of the above options are correct.

ICATS IT Contest 2017 (Juniors - Grade 5 & 6)
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(XD What happens when you press the icon circled in orange in the image below?

B )
@ 9 o @ B
R Rl o e
-~ = : 3] Fill - Z
rmat Cell Insert Delete Format ) Sort & Find &
sble = Styles = - - - (£ Clear ~ Filter = Select ~
5 Cells Editing

Y it moves the worksheet up and hides rows.

5} 1t minimizes the Ribbon.

E It opens another part of the Ribbon.

E It detaches the Ribbon from the worksheet and allows you to move it around.

CELD study the image below this question. What do the list of words (circled in
orange) in the Go To dialogue box represent?

I ca - (= £ 02

BB S E R EERED S e~ e -

|

ﬂ These represent named cell references in the worksheet. Clicking on an item in the list and
pressing OK will select the named cell reference.

B These represent column headings in the worksheet. Clicking on an item in the list and
pressing OK will take you to that heading.

ﬂ These represent formulas in the worksheet. Clicking on an item in the list and pressing OK
will take you to that formula.

E None of the above options are correct.

ICATS IT Contest 2017 (Juniors - Grade 5 & 6)
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INSTRUCTIONS

B Please recheck your Name, Father Name, Grade and School written below, the same would appear at your certificate.

This is a generic answer sheet to be used by participants of all grades. Students of Grade 1-2 will fill in circles of

first 20 questions, Grade 3-4 will fill in circles of 25 questions and Grade 5-10 will fill in circles of 30 questions.

Use of lead pencil is not allowed.

B Use only Black / Blue ink to fill in the circles.
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ICATS IT CONTEST 2018
JUNIORS (GRADE 5 & 6)

TIME ALLOWED : 90 MINUTES, MAXIMUM MARKS : 90
TOTAL QUESTIONS : 30 MCQS

INSTRUCTIONS

1.

DON'T START ATTEMPTING THE PAPER UNTIL INSTRUCTED BY THE
INVIGILATORS.

INSTRUCTIONS FROM THE EXAMINATION INVIGILATOR MUST BE CARRIED
OUTPROMPTLY.

CAREFULLY RECHECK YOUR NAME, FATHER NAME, SCHOOL NAME, ADDRESS
ETC AT THE BUBBLE SHEET / ANSWER SHEET.

RECORD ALL ANSWERS ON THE BUBBLE SHEET ONLY. SELECT BEST ANSWER
FROM THE FOUR GIVEN OPTIONS AND MARK ONLY ONE OPTION IN EACH
QUESTION.

USE BLUE / BLACK INK TO FILL UP THE CIRCLES FOR YOUR ANSWERS ON THE
BUBBLE SHEET. USE OF LEAD PENCILIS NOT ALLOWED.

USE OF ANY HELPING MATERIAL INCLUDING CELL PHONES AND
ELECTRONIC DEVICESIS STRICTLY PROHIBITED.

EVERY CORRECT ANSWER EARNS THREE POINTS. THERE WOULD BE
NEGATIVE MARKING. ONE POINT WOULD BE DEDUCTED FOR EVERY
INCORRECT ANSWER.

CANDIDATES MAY NOT LEAVE THE EXAMINATION ROOM UNESCORTED FOR
ANY REASON, AND THIS INCLUDES USING THE WASHROOM.

NO MATERIALS OR ELECTRONIC DEVICES SHALL BE BROUGHT INTO THE
ROOM.

. THERE ARE FIVE CATEGORIES OF THE CONTEST AS UNDER:

A TODDLERS (GRADE 1-2)
B. KIDS (GRADE3—4)

C. JUNIORS (GRADE 5—6)

D JUVENILES (GRADE 7 8)

E ADOLESCENTS (GRADE 9—10 / O-LEVELS)

. ONLY REGISTERED STUDENTS CAN PARTICIPATE IN THE CONTEST.
. NO CANDIDATE SHALL TAKE OUT OF THE HALL ANY ANSWER BOOK() OR

PART OF AN ANSWER BOOK, WHETHER USED OR UNUSED, OR OTHER
SUPPLIED MATERIAL.

. IF A PARTICIPANT DOES NOT UNDERSTAND A WORD OR PHRASE ON THE

EXAM PAPER, NEITHER EXAMINER NOR INVIGILATOR IS PERMITTED TO
ANSWER.

. FORINFORMATION ABOUT UPCOMING CONTESTS OR PROVIDING VALUABLE

FEEDBACK, PLEASE VISIT WWW.CATSCONTESTS.ORG

. ANY ACADEMIC MISCONDUCT OR MALPRACTICE MUST BE REPORTED TO

INTERNATIOAL CATS CONTESTS AT INFO@CATSCONTESTS.ORG
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3B Windows 7 is an Operating System launched by Microsoft in

N 2006 3 2007 K 2008 XY 2009

m When you press and release the primary mouse button, this action is called

u Click E Double-click E Programme presentation E Website

ED A collection of 1024 bytes is called

u Kilobyte E Megabyte Gigabyte E None of these

Ali asks his father about the uses of computer in the shopping mall. He wants
to know for which purpose the computer is used in the shopping mall.
What will be the answer of his father?

ﬂ For purchasing goods E For dealing with customers
For generating bills E None of these

ICATS IT CONTEST 2018 (JUNIORS - GRADE 5 & 6
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While working on computer Khadija has deleted one important file
mistakenly. Now she wants to restore the file. From which location she can
restore his file.

N My document 3 My computer [d Anyicons ] Recycle bin

I3 shahid writes five lines about his family on the computer. After sometime he
changes the monitor of his computer. What will he notice?

ﬂ The five lines he had written have lost
E The five lines he had written have lost partially
The five lines are still in the computer

E None of these

You are sitting at a computer as shown in the diagram.

After a while, your neck becomes
sore. Which of the following should

O you do before continuing?

ﬂ Raise the height of the chair.
E Lower the height of the chair.
ﬂ Move the chair closer to the screen.

E Adjust the brightness of the screen.

’ ICATS IT CONTEST 2018 (JUNIORS - GRADE 5 & 6
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T} The screen in Figure 1 shows an open window with four folders and a file.

My stuff NENX
File Edit View Help
. Art Project Science
Personal English
1 object(s) selected 18 bytes
————
Figure 1

My stuff
File Edit View Help

e a
.
.

Personal

1 object(s) selected

Science

English

18 bytes

Figure 2

In Figure 2, the mouse button has been clicked on the file ‘picasso’ and the file has

been dragged over the folder ‘Art project’.

What happens when the mouse button is released?

ﬂ The file “picasso’ will be deleted.
E The file *picasso” will be moved into the folder ‘Art Project’
The file *picasso’ will be copied into the folder called ‘Art project’.

E The file *picasso” will be moved on top of the folder called ‘Art project”.

I You are searching a compressed file in your computer. Which icon represents
a file you are looking for?

Recycle bin

[ A0 A AL T

ICATS.zip

ICATS IT CONTEST 2018 (JUNIORS - GRADE 5 & 6
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E1 1f you Cut a file from “Documents” folder then Paste it at “Music” folder then:

u You can find the file only at “Music” folder
E You can find the file only at “Documents” folder
You can find the file at both folders; “Documents” and “Music”

E You can't find the file at any folder; “Documents” nor “Music”

3EY 1n Ms. Word, the following icon is used to

ﬂ Open a file
E Save a file
Create a new Document

E Print Preview the document

What is the correct name for the words/labels circled in orange in the
image below?

WHY- O EGR&AY A@E|- Document2 - Microsoft Word
Home Insert Page Layout References Mailings Review View Developer
= 8 ibri - AN o[BS i = RS A |
By = Calibri (Body)  ~ |11 AN A | E-=-'p [EE (LT AaBbCcD¢
Pte 5 B I U x, X A -A- EEITE|E SH-EH- | tNoma
Clipboard = | Font “ | Paragraph

T SRS TN, IS T DS T RN A KN T KRS U IS 'O
“Uocument text by choosing a Iook Tor the selected text from the Uuick Style
tab, You can also format text directly by using the other controls onthe Ho
offer a choice of using the look from the current theme or using a format th
To change the overalllook of your document, choose new Theme element:

To change the looks available in the Quick Style gallery, use the Change Cur
command. Both the Themes gallery and the Quick Styles gallery provide res

c 1 200 -19- 01 18- -1?[ﬁ]

can always restore the look of your document to the original contained iny

Y The Ribbon Names. 3 The Quick Access Toolbar.
The Ribbon Tabs. E None of the above options are correct.

_

ICATS IT CONTEST 2018 (JUNIORS - GRADE 5 & 6
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m Study the image below this question. Where is the Status Bar located?

D pe G Yew Inmt Fonet ook Table Wedow tish e ————
i [l g o - g sinent

AR ™ IR NI WGl 7 W TR WS 10 SO Y W e - 1 _ |
i A4 tiomal - Trmhenbonn - 12 - B 7y [ElE=E =0 e

Gitvenr g | Autoshepes= N v C10 < ol 3 (] | =

u At the top of the screen denoting the document name (Documentl — Microsoft Word).
E The bar located at the bottom of the screen that allows you to move the view to the right or left.
The groups of icons located at the top of the screen which is also known as the Ribbon.

E The bar at the bottom of the screen that gives information such as Section, Page, Words, etc.

You want to make changes to your document but keep the original document
intact. What should you do?

ﬂ Press Save As, give the document a new nhame. Make changes as needed.
E Make changes to the document, press save and close the document.

Press Save As and give the document the same name as it currently has. Make changes
as needed.

E Make changes as needed to the document, press Save and then save the document with a
new name.

ICATS IT CONTEST 2018 (JUNIORS - GRADE 5 & 6
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Study the screenshot below. If you started typing, what would the last three
words before the new line of text you type be?

with your current document look.

theme or using a format that you specify directly.

your document. |

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of
your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and
other document building block. When you create pictures, charts, or diagrams, they also coordinate

You can easily change the formatting of selected text in the document text by choosing a look for the
selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using
the other controls on the Home tab. Most controls offer a choice of using the look from the current

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of

When you create pictures, charts, or diagrams, they also coordinate with your current document look.
You can easily change the formatting of selected text in the document text by choosing a look for
selected text from the Quick Styles gallery on the Home tab.

document.

third paragraph.

o o I >

the first paragraph.

None of the above options are correct.

The text you type will be inserted after the words: "the Home tab." at the end of the

The text you type will be inserted after the words: "of your document" at the end of the

The text you type will be inserted after the words: "current document look." at the end of

31 study the screenshot below. You will notice the Cut and Copy buttons are
greyed out (not available). How can you make them active so that they are

available to use?

You first have to paste all the content on the
Clipboard before you can cut or copy more.

You first have to select content to copy or cut
before the buttons will become available.

B O B

You first have to use Ctrl+c or Ctrl+x to copy
or cut content before you can use the Cut
and Copy buttons.

None of the above options are correct.

_

ﬁ,:.i d9-02 =

Home Insert

B Calion (Bod)

Fage Layout References Mailings Resiew Vi

B T —=er -

Pate o, [B 4 U ke x % B (W - A EEEEE

Olipbosrd 7+

Faml . Sarageaph
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Alina is editing the last paragraph of her essay. She has decided to add
another sentence before the last sentence. Which of the following would be
the most efficient process?

u Type the sentence in another document and then place it in her essay where she wants it.
E Type the sentence at the end of her essay and then move it to where she wants it.

E Type the sentence at the end of her essay, copy the new sentence, and then paste it where
she wants it.

E Put the cursor at the point where she wants to add the sentence and then type the sentence.

m In a Science lesson, you need to edit your essay on butterflies.

Butterflies can identify their favourite plants from miles away and travel for
hours to taste the nectar of the flowers. They will lay eggs and remain nearby
as long as you tend your garden, keeping it healthy and blooming. [

difficult to make your backyard home to dozens of butterflies at a time.

Figure 1

Butterflies can identify their favourite plants from miles away and travel for

hours to taste the nectar of the flowers. il kXe il iR M=l CR o1 [l oF=1e1 4210
Lol pa L (oo o A=TE o] MoV i[RI R=RiN W They will lay eggs and remain nearby

as long as you tend your garden, keeping it healthy and blooming.

Figure 2

The highlighted text needs to be moved from the position in Figure 1 to the position
in Figure 2.

What is the best way to make this change?
ﬂ Cut and paste. E Cut and delete. E Copy and paste. E Copy and delete.

NN
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8 0OF 16

m How has the Tab key been used in formatting the text below?

The International Fire
Information Network
Firenet is an online information
service for those interested in
rural and landscape fires. The
site covers all aspects of fire
science and management -
including:

fire behaviour,

fire weather,

fire prevention,

mitigation,

suppression,

plant and

animal responses to fire
and all aspects of fire effects.

ﬂ To create the heading B To justify the text
The Ribbon Tabs. E To create the border

XD 1f you quickly want to undo or redo an action, which shortcut keys would

you use?
N ctri+z and Ctri+y [ ctri+uand Ctri+r
Ctrl+un and Ctrl+re 2] Al of the above shortcut keys will work.

ICATS IT CONTEST 2018 (JUNIORS - GRADE 5 & 6
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29 You type the following information into a word processor document.

The Olympic flag shows five coloured rings on a white background.
The rings symbolise the uniting of the five continents of the world.

You wanted the text to look like this:

e  The Olympic flag shows five coloured rings on a white background.
e  The rings symbolise the uniting of the five continents of the world.

You select/highlight the text on your screen. What tool key should you use next?

O — O:-— c R 2=

X} Someone typed the following passage in a word processing software

Probably one of the smartest and least troublesome habits you can get into is to enter
data regularly into your hardware and software maintenance diary. The more data you
provide in your diary the better. Always keep a diary of what you check on each
computer, When you run a backup, what you backup, and the content of the hard drive.
A diary helps you to identity and isolate problems at an early stage.

Find What: | diary | |_Find Next_|
| Replace |
Replace All

Replace With:llog | [ cancel |

Which of the following buttons is used to replace the word diary with the
word log every time it appears in the above paragraph:

Y Find Next ] Replace Replace All ) cancel

NN
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Study the image below. Which of the following actions will allow you to
exit the Backstage View and continue working in the actual workbook?

Lz.] Microsoft Excel - Budget.xin
“' Home  Iniemt  Pagelayout  Farmulas  Data  Revew  View  Developer

bl save ;
=~ Information about Budget
ve As
G:\G. Formulas and Functions\Budgetadsx
| Open
[ Close -
- Permissions
info _r;iji Anyone can open, copy, and change any part of this workbook.
Protect
Recent Workbook *
New

Prepare for Sharing
A
Print { J Before sharing this file, be aware that i contains:
Document properties, ponter path, authot’s name and relate:

Save & Send Cl:::::?' Content that people with disabilities find difficult to read
Help
1] Options ; Versions
( ﬂ \) There are no previous versions of this file
k3 Exit
Manage
Versions ~
ﬂ Pressing the Home tab. E Pressing the Exit button.
Pressing the Close button. 2] Al of the above options are correct.

You made some changes to a workbook called "Sept 2014". You then clicked
Save As, typed "Sept_2014_New" in the File Name box and clicked Save.
Which of the following statements is true?

The changes you made to "Sept 2014" will be reflected in the new workbook,
"Sept_2014_New" only.

The changes you made will be reflected in both versions, "Sept 2014" and "Sept_2014_New".

R B

By using the Save As function you replaced the file "Sept 2014" with "Sept_2014_New".
The original file no longer exists.

The changes you made will stay in "Sept 2014" and will not be reflected in "Sept_2014_New".

_
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Your boss asks you to insert the company logo into your worksheet so that it
will automatically display at the top of every printed page. How will you go

about doing this?

ﬂ Display the worksheet in the Page Layout View and manually insert the company logo into the

top of each individual page.

E Add the company logo to the header or footer of the first page in the Page Layout View.

Insert the company logo into the top of the worksheet in Normal View.

It will automatically repeat.

E It is not possible to insert logos into Excel. Instead print the worksheets on company headed

paper that contains the logo.

EIB You have just realised that you need an extra row at the end of the table
shown. How would you go about achieving this?

Birthday

Phone No

March 12

0324977927

January 12

0331233215

June 29

0319212921

Cilrawe g Moshepes= N v C1O ~d ol 02 il -

N Delete the table and start again.
Use the Insert Row function.

ICATS IT CONTEST 2018 (JUNIORS - GRADE 5 & 6

E Use the Insert Column function.
E Press Enter/Return in the last row.

NN




12 OF 16

The screenshot shows an email with multiple attachments

Message HOD
| ¢ To: maxwell@luna.org
L.t Ce
___ Bece:
Subject: Files you asked for
Attach: composition.mp3 (2.88 MB) worlds.pdf (891 KB)
holiday.mov (13.4 MB) application.doc (34.5 KB)
—=
Hi Max I
| have attached the various files you wanted to see.
Cheers
Leonardo =
Which attachment has the largest size?
ﬂ composition.mp3 B holiday.mov worlds.pdf E application.doc

m Which of the following statements is correct?

N johndow@yahoo.com is a web site (url).
E johndow@yahoo.com is an email address.
johndow@yahoo.com is a computer name.

E johndow@yahoo.com is a robot.

ICATS IT CONTEST 2018 (JUNIORS - GRADE 5 & 6
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Study the image below and answer questions 29 and 30.

To: linmcrms@cooina'rl.oom.au l Attachments: | %) |mwitation

ce: | |
Subject: | Year 10 Formal |

Hi Chris,
Re: End-of-year party

| have drafted an invitation. If this is ok, please
sand it on to our friends.

Regards

-
',_'!
Jo —
ZED what is the best way for Chris to thank Jo for the information?
u Click on Reply. E Click on New Memo.
Click on Forward. ) click on Copy into.

m Chris wants to send this email to other people. What is the best way to do this?

N Click on Reply. 3 click on New Memo.
Click on Forward. ) click on Copy into.

ICATS IT CONTEST 2018 (JUNIORS - GRADE 5 & 6
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DON'T START ATTEMPTING THE PAPER UNTILINSTRUCTED BY THE INVIGILATORS.

INSTRUCTIONS FROM THE EXAMINATION INVIGILATORS MUST BE CARRIED OUT PROMPTLY.
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m In the 1980's manufacturing of semiconductor chips was done, The Intel and
Motorola Corporations were very competitive into the 1980s, although Japanese
firms were making strong economic advances, especially in the area of memory
chips. By the late 1980s, some personal computers were run by microprocessors
handling of data at a time.

X3 All the human beings in this world communicate with each other by a language.
Similarly, computer also needs some language to communicate with others.
A computer follows the instructions given by the programmer to perform a
specific job. To perform a particular task, programmer prepares a sequence of
instructions, known as program. A program written for a computer is known as
Software. When the human being stared programming the computer, the
instructions were given to it in a language that it could easily understand.
In that language, the instructions were given to the computer in the form of
1s and 0s. What was that language called?

| A | High Level Language | | C | Assembly Language |

| B | Machine Language | | D | Query Language |

CED 1 am used to enter information directly into the computer memory. I work like a
Xerox machine. I convert any type of printed or written information including

photographs into digital pulses, which can be used / processed by the computer.
Do you know me? Who am I?

B | Keyboard C | Light Pen
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(I A memory is just like a human brain. It is used to store data and instructions.
Computer memory is the storage space in computer where data is to be
processed and instructions required for processing are stored. Memory is primarily
of three types

*Cache Memory
‘Primary Memory or Main Memory
‘Secondary Memory

I am a very high speed semiconductor memory, faster than all other memories,
which can speed up CPU. I am used to hold those parts of data and program which
are most frequently used by CPU. The parts of data and programs are transferred
from disk to me by operating system from where CPU can access them. Who am I?

| A | Cache Memory | |C | Secondary Memory |

|B | Primary Memory or Main Memory | | D | None of the above |

LX) which of the following is the correct way to hold the mouse?




| C | System Unit | | D | Network Hub |

I type the following in MSWORD document:

dogcatboyman

1. I put the cursor after letter “g” and then I press ENTER BUTTON once
2. I put the cursor after letter “t” and then I press ENTER BUTTON once
3. I put the cursor after letter “y” and then I press ENTER BUTTON once

What and how will be written there?

|A | dog cat boy man | B | dog cat
boy man
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You opened MS Word document in your computer. You press Caps Lock Key
and type the following words:

mouse, keyboard and monitor

What and how will it be written in your document?

| A | Mouse, keyboard and monitor | | C | Mouse, Keyboard And Monitor |

| B | MOUSE, KEYBOARD AND MONITOR | |D | mouse, keyboard and monitor |

m You opened MSWORD document in your computer. You typed the following
sentence:
My brother has 4 small doge | is.
You notice that the spelling of dogs has been incorrectly typed. If your cursor is
between letter e and i, which keys will you press to correct the spellings?

|A | delete key once | | C | backspace key once and delete key once |

| B | backspace key once | |D | All of the above |

You can press me to fast forward your video in multimedia player of your
computer. Can you guess which of the following am I?

~ @
= @
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The home row of the keyboard is the most important to the typist. The row of
keys A, S, D, F, J, K, L, ; on the keyboard is called the home row. The fingers are
positioned, lightly, on the A, S,D,F keys for the left hand, and the J, K, L, ; keys
for the right hand.

*The left index finger will control the F key, the right index finger will control
the J key.

*The left middle finger will control the D key, the right middle finger will control
the K key.

*The left ring finger will control the S key, the right ring finger will control the
L key.

*The left little finger will control the A key, the right little finger will control the
; key.

*The spacebar is controlled by the right or the left thumb.

Which finger will be used to control the T key?

| A | Right index finger | | C | Right middle finger |

| B | Left index finger | |D | Left middle finger |

In MSWORD document, which of the following contains the commands you use
most often, such as Save, Undo, and repeat?

| A | Quick Access Screen |

| B | Quick toolbar |

ICAf§I‘[ Coht_est 2019 (Juniors - Grade 5 & 65




In MSWORD document, the headings that appear on the Ribbon, such as File,
Home, and Insert, are called:

In MSWORD document, which of the following options would you use when
saving a document with a new filename?

[D/ Eitheraorb |

You can see the first letter “"T” of the following paragraph typed in the MSWORD

document. Which option was used to make the “"T” look like this big and occupy
three lines?

Home Insert Page Layout References Maibings

B 4y =) 3 Header - A

L .

] Skl o Footer -

Picture Chp Links Text
Art = =) Page Number = Box~

o

Wustrations Header & Footer |

past few years We are all aware of the tactics the RIA
of Amenca) is using to halt consumers from sharing coj
supeona’s and lawsuits seem to be issued on a daily basis T
new technology and incorporate it into their business model in
abenate music fans, which are the consumer base they wish t

The issue of sharing music files over the internet has bex

A | WordArt B | Text Box C | Drop Cap
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Read the following passage and answer questions 16 through 20

Text or word processing generally refers the use of computers to manipulate text. Examples of
word processing functions include entering, editing, printing, etc. Using formatting tools we can
change the look and feel of the text typed. We can change the font style / size, make the text bold /
italic, underline, etc. Apart from these functions we can also highlight the text and change the
background colour. The following figure shows some of the tools available to format the text:

[Waw@un - . T PP e e s

Fuet  Peprimed  Bfmene Mg Seeew Ve

Comatione 1L c N A % = TR DT e ameie AaBLG aabce AAD
o "~

gl o B deaw v-A-mEuE v 3 _ Shmns |Theises. Funtegl | Meieg) Skitn  adita

a Faem

!
i

You can press me to justify your text alignment. Can you guess which of the

= B

following am I?

| D | All of these |

You can press me to highlight your text. Can you guess which of the following
amI?

w aty <

IQ | D | All of these |
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You can use me to change the font style of your text. Can you guess which of
the following am I?

A A 1

A

A [0]  Calibri (Body)

I am used to make a bulleted list in your document. Can you guess which of the
following am I?

| C | All of the above |

|D | None of the above |

I am used to insert a text box into your document. Can you guess which of the
following am I?




m Raju is preparing a document. He wants to include a table in the document.
Can you tell him which option he should select first?

In MSWORD document, on the Home tab, in the Paragraph group, there is Line
and Paragraph Spacing button to display the Line Spacing menu and options to
add and remove spacing before and after paragraphs (see image given below).
What are the following options used for?

v 10
1.15
1.5
2.0
2.5
3.0

| A | Adding space before paragraph | |C | Changing line spacing |

| B | Adding space after paragraph | |D | All of the above |

Which of the following refers to how text is positioned between the top and
bottom margins of the page?

| A | Horizontal alignment | |C | Justification |

| B | Vertical alignment |
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m The Layout tab contains groups of commands that control the layout of an entire
document or sections of a document. Commands in the Page Setup group
(see image below) enable you to set margins, change the document's page
orientation, and adjust the paper size. Columns enable you to split a document

into two or more columns.

The Layout Tab

(e |

Irert

B ©
. Ousige
TRy e Coreaksd

. T 7 |EE|
= ) | - L | lnl N " .
Marging Onertation  Sae  Columng -

Page Setup

Layout Feterences

sl Hyphenation

Docurment] - Word
Maddngt e

Indent Spacing
e 0 : & Before Opt
B¢ Right: 0" S taAher Bpt

Faragraph

View

What is the button in red circle used for?

| A | To insert Page break |

|B | To insert Section break |

|C | To insert Table break |

|D | Both, Aand B |

m In MSEXCEL, the options “Portrait” and “"Landscape” (as shown in the image

below) are called

D Portrait

Landscape

|A | Page orientation | |[B | Page direction |

|C | Page size |
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m In MSEXCEL, Zoom slider is located at the right end of the status bar
(see image below). Each time you click the Zoom in / out button, it decreases
the size of the displayed portion of your spreadsheet by %o.

Zoom Slider
orization ® A

COUNT: 2 H B M| -——+ 100%

In MSEXCEL, what the options shown in the below image are called?

jiﬁﬁgﬁ%d-;

|A | Copy options | B | Paste options | | C | Formatting options | | D! All of the above |

m In MSEXCEL, what is / are the button shown in the below image is used for?

Delete
v

|A | To delete cell | |C | To delete the sheet |

| B | To delete sheet rows and columns | | D | All of the above |
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@ I am a famous and commonly used web browser. Which of the following am I?

[ D Internet Explorer |

m I am a language used to create web pages. Which of the following am I?
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